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ADCPro™ User Guide

This user's guide describes ADCPro™, a software tool for evaluating analog-to-digital converters (ADCs).
This tool is provided along with many evaluation modules (EVMs) from Texas Instruments to assist
customers in evaluating a broad range of ADCs for various applications.

1 Introduction and Requirements

ADCPro is a modular software system from Texas Instruments for evaluating ADCs without the need for
expensive logic analyzers and complex analysis routines. As a stand-alone tool, it is suitable for analyzing
data sets captured during ADC testing. When paired with a Texas Instruments ADC EVM and suitable
data capture card, it becomes part of a powerful evaluation package.

1.1 Features
» Ability to save and recall data sets
e Modular design allows additional EVMs and tests to be supported
« Time, histogram, and frequency domain testing

This manual is designed to help easily set up an evaluation system that closely replicates a
manufacturer's system, and allows the user to arrive at meaningful results that can be compared to
system requirements. Tests that are performed and the equipment required to perform these tests will be
discussed; detailed test methodologies are also examined.

In this document, we identify the appropriate test equipment for use with an EVM and review basic ADC
evaluation test methods. Essential performance parameters of an ADC are described, as well as how
these parameters are characterized by following the IEEE Standard 1241-2000, the IEEE Standard for
Terminology and Test Methods for ADCs. ADCPro implements some of the tests described in IEEE1241-
2000. As a result of the modular ADCPro design, additional tests can be added to any installation of
ADCPro as needed.

When running the ADCPro, the user is actually using three programs: a shell program that loads plug-ins;
a plug-in program that communicates with the EVM hardware; and a test plug-in that analyzes data
coming from the EVM plug-in. This modular design allows ADCPro to be used with a number of different
data capture cards or motherboards that may ship in an EVM product development kit (PDK). Data files
saved from ADCPro can be recalled for further analysis using an EVM plug-in that reads files.

ADCPro is a trademark of Texas Instruments.

Agilent 33120A is a trademark of Agilent Technologies, Inc.

Audio Precision is a trademark of Audio Precision, Inc.

Pentium IIl, Celeron are registered trademarks of Intel Inc.

Microsoft Windows, Windows are registered trademarks of Microsoft Corp.
Microsoft, Excel are registered trademarks of Microsoft Corporation.

All other trademarks are the property of their respective owners.
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1.2 Minimum System Requirements for ADCPro
* PC with:
— Pentium Ill®/ Celeron® 866MHz or equivalent processor
— Minimum 256MB of RAM (1GB or greater recommended)
— Hard disk drive with at least 200MB free space
* Microsoft Windows® XP SP2/SP3 and Windows® 7 operating systems
* Mouse
» Optimized for 1024 x 768 resolution

NOTE: Microsoft Windows® 7 includes an option in the Control Panel to scale overall display
magnification, see Control Panel > Appearance and Personalization > Display. It is
recommended that ADCPro be run on systems with the display magnification set to "Smaller
- 100% (Default)" to avoid overlapping text/controls.

1.3 Additional Requirements for Use with Hardware
e TI ADC EVM-PDK: evaluation kit that includes data capture card and device EVM (optional)
e USB 1.1-compatible input (check requirements of individual EVMS)

Other configurations may work, but have not been tested. Users should be advised that when capturing
larger data sets, PCs equipped with faster processors and larger RAM tend to perform better.
1.4 ADCPro Installation

For installation instructions please refer to the ADCPro Hardware and Software Installation Manual.

2 ADCPro Launcher

The ADCPro Launcher is a utility provided to ease installation and maintenance of ADCPro. From the
Launcher the user may install ADCPro and ADCPro plug-ins, apply updates to ADCPro, visit the TI E2E
community, and search for devices at www.ti.com.

s ADCPro B T ) -

i

I

Completing the ADCPro Setup
Wizard

ADCPro has been installed on your computer,

Click Finish to dose this wizard.

["] Run ADCPro

¥ Enable Launcher app on ADCPro startup?

ADCPro User Guide

Figure 1. ADCPro Launcher Enable/Disable Switch

The ADCPro Launcher can be enabled or disabled on start-up once ADCPro is installed on the PC. At
completion of the ADCPro installation, the prompt shown in Figure 1 will be displayed. The Launcher can
also be enabled or disabled from the ADCPro toolbar under Settings > Configuration Settings - as
discussed in Section 3.3.

NOTE: No user data outside of the ADCPro and ADCPro plug-in installation is inspected by the
ADCPro Launcher. No data on the PC is monitored or reported back to Texas Instruments.
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2.1 Welcome Tab
The Welcome tab is displayed for users who do not have ADCPro installed or for users who are migrating
from ADCPro v1.2.2 to ADCPro v2.0.0 and beyond. Installed ADCPro plug-ins will be shown on this tab
and may be selected for update to be compatible with the new version of ADCPro. Click the Get ADCPro
button once all desired components to convert are selected and the Launcher will begin downloading and
installing the requested features.
" & ADCPro Launcher oo
File Help
Ready
Whats new in ADCPro?
-Windows ¥P and Windows 7 Support
-ADCPro Launcher for easy access to new plug-ins, support, and updates.
-Architectural upgrades to plug-ins for faster performance
-Improved test and utility plug-ins (MultiFFT, MultiHistogram, MultiScope, and
Instzlled Plug-ins
Select currently installed plug-ins to convert for ADCPro. Click on the "Get ADCPro” button
at the bottom of this screen te begin converting and installing compenents.
ADCPro
Figure 2. ADCPro Launcher Welcome Tab
2.2 General Tab
The General tab is the default window for the ADCPro Launcher. This window will always be the first page
visible unless ADCPro is not installed on the PC, in this case the Welcome tab is made visible and the
user will be prompted to install ADCPro.
From the General tab the user may check for ADCPro updates, search for new ADCPro plug-ins, visit the
Precision Data Converters E2E Community, search for Precision Data Converter products at www.it.com,
and launch ADCPro. Additionally, a message of the day is displayed on this tab to present Precision Data
Converter and ADCPro announcements.
NOTE: To Launch ADCPro return to the General tab.
Fle Help ]
Ready
Check for Search for Install Visit the TI Search Tl.com
l Updates l new plug-ins Compenents \EZECDmmumty for devices
HNews: -
02/28/12
Welcome to the ADCPro Launcher. Use the navigation buttens to access updates, new plug-
ins, search for devices at Tl.com, and visit the E2E Community.
-ADCPro v2.0.0 Internal Beta begins!
ADCPro
Figure 3. ADCPro Launcher General Tab
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2.3

24

Updates Tab

The Updates tab is accessed by clicking the Check for Updates button on the General tab. The ADCPro
Launcher will scan the PC for installed components and component versions. If updates are available for
the ADCPro shell or individual plug-ins they will be populated in the Update tab, as shown in Figure 4.

File Help

General  Updates | [nstall Ready

[] ADCPro Shell

[71] ADS1174 plug-in

[C] ADS1178 plug-in

Select desired components and click download to update ADCPro [Download Selected
plug-ins. Completed downlosds will appear in the "Tnstall” Tab.

Figure 4. ADCPro Launcher Updates Tab

To select an item for update click the check-box next to the item. Once all desired updates have been
selected, click the Download Selected button and follow the prompt to either confirm or cancel the
requested downloads. As the downloads complete the items will be removed from the Updates tab and
placed in the Install tab.

NOTE: While the ADCPro Launcher is downloading components the GUI is locked from all user
interaction. Status messages and status bar in the upper right corner will reflect progress.

Search Tab

The New Plug-ins tab is accessed by clicking on the Search for New Plug-ins button on the General tab.
The ADCPro Launcher will scan the local system for installed ADCPro components and display
components that are not yet installed on the PC. Plug-ins that are already installed on the PC but may
have available updates will not be displayed on this tab. Updates are only displayed on the Updates tab.

To select an item for download click the check-box next to the item. Once all desired components have
been selected click the Download Selected button and follow the prompts to either confirm or cancel the
requested downloads. As the downloads complete the items will be removed form the New Plug-ins tab
and placed in the Install tab.

The New Plug-ins tab also features a search bar that may be used to search for specific plug-ins to install.
Items selected for download will remain at the top of the displayed list of plug-ins as the search string
changes. The search bar is prepared to accept regular expressions, or special characters, for advanced
searches. For more information concerning special search characters, please refer to the ADCPro
Launcher Help.
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FEile Help I
General Mew Plug-ins | Install | Ready
sit 7]

~

[7]| ADS1174 plug-in
[]| ADS1178 plug-in
[7]| ADS1274 plug-in
[7]| ADS1278 plug-in
]| ADS1672 plug-in

[71| ADS1675 plug-in

Select desired components and click download to acquire new ADCPro [0 oo e g

plug-ins. Completed downloads will appear in the "Install" tab.

Figure 5. ADCPro Launcher New Plug-ins Tab

2.5 Install Tab

The Install tab is made visible either by clicking the Install Components button on the General tab or by
clicking the Check for Updates or Search for New Plug-ins buttons on the General tab. When downloads
are complete from either the Updates tab or New Plug-ins tab the Install tab will be made visible. The
Install tab presents all of the components that have been downloaded on the PC. Items can be installed
individually by double-clicking on the item name or all items can be installed automatically by clicking the
Install All button.

NOTE: If an update has been downloaded for the ADCPro shell and components are installed
manually, it is important to run the ADCPro shell installer first, followed by each desired
component. Alternatively, the Install All button will automatically run the shell installer first if it

is present.

FEile Help |

General | New Plug-ins  Install iy
ADSL174 plug-in A
ADSL178 plug-in
N ety ot ADCF e o ADCPe e .
Figure 6. ADCPro Launcher Install Tab
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3.1 Launching ADCPro
From the Windows Start menu, select ADCPro....

When ADCPro begins, it displays a splash screen (Figure 7). This screen shows the version number of
the software. the user can also find the version humber under the Help menu.

Analog-to-Digital Converter
Evaluation Software

Figure 7. Start-Up Splash Screen

After a few moments, the software initializes and the splash screen disappears. The screen shown in
Figure 8 then displays.

X

File EVM Test Tools Settings Help ‘

Figure 8. Initial ADCPro Screen
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3.2

ADCPro Architectural Overview

ADCPro is built upon a plug-in architecture using LabVIEW software. The main program, shown in
Figure 8, is called the shell. The shell loads plug-ins to collect and analyze data.

Data are collected for analysis using an EVM Plug-In, so hamed because in most cases the data are
collected from a TI EVM via a hardware interface, usually over a universal serial bus (USB) connection.

When the shell initializes, it scans a directory named evm in the plugins ADCPro directory and populates
two menus, EVM and Test, with any plug-ins it finds. Plug-ins that provide data to the ADCPro software
are classified as EVM plug-ins, while those that take the collected data and analyze or manipulate it are
classified as Test plug-ins.

To use ADCPro, the following steps are required:

e Load an EVM plug-in

e Load a Test plug-in

To load an EVM plug-in, select it from the EVM menu. To load a test plug-in, select it from the Test menu.
To unload a plug-in, select the Unload option from the respective menu.

Only one of each type of plug-in can be loaded at a time. If selecting a different plug-in, the previous plug-
in is automatically unloaded.

3.3 ADCPro Main Menus
The ADCPro shell screen has four drop-down menu options: File, EVM, Test,Tools, Settings, and Help.
* The File menu contains three items: Minimize EVM Plugin, Screen Capture of ADCPro Screen, and

Exit.

— The Minimize EVM Plugin item collapses the EVM plug-in panel to allow the Test Plug-in to expand
to the entire ADCPro main panel. This action can also be performed using the F8 function key.
Selecting the menu item again or pressing the function key will restore the main panel to the default
display.

Figure 9 shows an enlarged view of the Multiscope plug-in panel.
#4 ADCPro
File EVM Test Tools Settings Help
d ‘ Acquire ' | Continuous ' Data recorder samples ﬁa
Multichannel Scope
125
Ilﬂlll \lll.l‘ll i ! ’ i h ‘III ‘I rl‘| hl‘ Ir Iﬁl I| ' i || “r b \
e \I‘ I|I|| | |‘||\ I‘ i nl|,||\ : J ‘|‘
e (l‘ ,'I HIJ |' “\ i I‘“I""' | mu }‘ 'l’. ‘|.""|' 'l"||‘.\. i !rl"‘,lfl'l". l"|| “"| i ""|‘;‘|'|‘ J;'w'i
m | I A | ! ] , | ]
§ ,Ill ‘|I| |“,|| Il\‘\lx 'f‘ i I||II ' '|'||\|||' L] II‘IIH |' ,‘I ||\ || u . J‘II‘ ‘H j ‘ ||I|1 |II II|| '|' ||"
||\ ” | I‘I|‘ |”n || F |.JI|' |] | 'u\ "IH‘ "‘ ||'u|‘ ‘\ | IHI| I|| | \"I ‘|".,| HII‘ IIII I” | u |\ '| |\ ‘ |'I \I
-1-2.57
7 6;11 8‘0 160 12‘0 1410 1!110 léﬂ 26!] Ziﬂ Ziﬂ llliﬂ Zéﬂ 360 Eiﬂ 34{0 3!110 Eéﬂ 460 4iﬂ diﬂ 4!’;{1 4é0 ‘51‘1
Samnle
|C||rsols. | X | Y =1 --.gjﬂ‘
= Magnitude Scale Settings|
Lo O Block size fense O
2 Units odes
ChanneIsCHl S JIT O 50:5
Custom
Figure 9. ADCPro Main Panel with Test Plug-in Maximized
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3.4

— The Screen Capture of ADCPro Screen item allows the user to capture the main panel of ADCPro
in one of three file formats: jpg, png, or bmp.

— The Exit item closes the ADCPro software when selected. This action can also be performed by
using the Alt+Q key combination.

« The EVM menu contains a list of all the EVM plug-ins currently installed. Further information regarding
EVM plug-ins is given in Section 3.4.

» The Test menu contains a list of all the Test plug-ins currently installed. See Section 3.5 for more
information regarding Test plug-ins.

» The Tools menu contains a list of all the basic tools for ADCPro. Additional information regarding tools
is provided in Section 3.6.

e The Settings menu allows access to the ADCPro Configuration Settings menu, shown in Figure 10,
where the user may enable or disable the ADCPro Launcher and view error logs.

= ]
ﬂi ADCPro Configuration Settings @
[#]Enable Automatic Update check using Launcher
Open Error Log
L l
= )

Figure 10. ADCPro Configuration Settings Menu

» The Help menu contains three selections: About ADCPro... and Contact Us.

— The About ADCPro... item displays information regarding the current version of the ADCPro
software and the names and versions of the active plug-ins.

— The Contact Us item allows for comments and questions to be sent via email to
adcpro_help@list.ti.com. Questions and comments assist us in program development and
designing further software enhancements.

EVM Plug-Ins—Getting Data Into ADCPro

As a stand-alone program, with no hardware connected, ADCPro can be used to analyze data sets. This
feature is an easy way to evaluate the tool. Data can come from two different plug-ins included in the
distribution:

» TripleGen: a 3-channel function generator EVM plug-in;
* FileReader: an EVM plug-in that reads data files stored in the ADCPro format (tab-delimited text).
Since both of these plug-ins provide data to the analysis engine, they are considered EVM plug-ins, and

appear under the EVM menu in the ADCPro shell. Selecting an EVM plug-in to use with ADCPro is done
by simply selecting one of the menu items in the EVM menu; see Figure 11.

|
oo
File Ii;l Test Tools Settings Help

ADSI1T4EVM
" | ADS1178EVM Lous | Data re
| File Reader

Triple Generator

Figure 11. Selecting an EVM Plug-In
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34.1 TripleGen
The TripleGen plug-in is a software function generator, and is included with the main ADCPro distribution.
This EVM plug-in can create and feed data blocks to tests for analysis. It is a tool for verifying that tests
function properly. See Figure 12.
The signals are generated using controls for each channel. The available controls are:
* Resolution: the number of data bits for the waveform data.
» Max code: the maximum code value (signed integer) of the data.
* Min code: the minimum code value (signed integer) of the data.
* Fs: the sampling frequency of the channel data (in Hz).
NOTE: The sampling frequency (fs) of Channel 2 and 3 is always the same as that of Channel 1.
e Max V: the maximum voltage value of the waveform.
e Min V: the minimum voltage value of the waveform.
»  Waveform: the type of waveform to be generated. The types of waveforms available are:
— Sine, Square, Ramp Up, Ramp Down, Triangle, Pink Noise and White Noise
* Frequency: the frequency of the generated signal (in Hz).
* Amplitude: the amplitude of the generated signal (referenced to 0dB).
Channel 1
16-bit, Sine @ 1.0000kHz, 0.0 dBFS -
Channel 2
16-bit, Sine @ 1.0000kHz, 0.0 dBFS C ii;
Channel 3
16-bit, Sine @ 1.0000kHz, 0.0 dBFS ( Ia
Sampling Frequency I 44100 5PS
Channell =< l
Waveform I Sine
Resclution |16
Max Volt |15 Max code |32?67
Min Volt |—15 Min code |—32?68
Signal Frequency I 1kHz
Amplitude (dBFS)
150 125 100 75 50 -35 0
Figure 12. TripleGen EVM Plug-In Front Panel Display
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342 FileReader

The FileReader plug-in allows a file that contains a data set to be loaded into the ADCPro shell so that the
data can be analyzed using one of the test plug-ins. It is included with the main ADCPro distribution.

The format of data files that the FileReader can read is described in Section 3.5.5. These files are tab-
delimited text files.

The FileReader main panel is shown in Figure 13. To load a file into the FileReader plug-in, select the
folder button to the right of the File Path and Name control. Navigate to the active directory and select the
text file to read. Alternatively, the file path and information can be manually entered into the window. If the
file is a valid file, the LED to the right of the File Path and Name controls should turn green. The header
data from the file should be displayed in the File Information area of the panel. The CH_Attrib selector
can be changed to view the individual channel information read from the file.

File Path and Name

B =
[Rescanile] @

Device I

Date and Time I

Channel Infermation

Motes

Figure 13. FileReader Plug-In Front Panel Display

The data in the specified file are read only once at the initial loading of the file. Subsequent acquisitions
performed by the user do not re-scan the file for any changes and operate from the data stored in
memory. The Rescan button allows the user to rescan the input file without having to reload the file in the
File Path and Name control. This can be useful when reading in a file for analysis that is periodically
updating while ADCPro is running.

The channel data contained in the file should be available to read via the Acquire (or the F5 function key)
or Continuous function (or the F6 function key) when a Test plug-in is loaded. The channel data are read
beginning at the start of the file, regardless of how many Acquire cycles are issued or the number of data
points acquired.
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3.4.3

3.5

Other EVM Plug-Ins

When physical hardware is available in the form of an EVM-PDK or other evaluation platform, ADCPro
support is provided through the use of an EVM plug-in that comes with its own installer. Running the
installer places the EVM plug-in into the plug-ins directory of the ADCPro software. EVM plug-ins
generally control any features of the ADC (for example, register settings that control onboard multiplexers
or programmable gain amplifiers, as well as parameters such as sample rate). Consult the documentation
that comes with the specific hardware and EVM plug-in for details on using the EVM plug-in with ADCPro.

Test Plug-Ins—Analyzing and Saving Data

In order for the ADCPro shell to enable the Acquire and Continuous buttons, both an EVM and Test
plug-in must be loaded. A test can be selected from the Test menu, as shown in Figure 14.

v oo M

File EWM Tools  Settings  Help

Data Monitor
MultiFFT
MultiHistogram

M | Acg ] Data recor

e

MultiScope

Figure 14. Selecting a Test Plug-In

ADCPro can perform an analysis in either one-shot or continuous mode. In one-shot mode, the program
collects a number of samples, analyzes them, and stops. In continuous mode, the one-shot operation is
performed repeatedly.

If performing one-shot analysis, all of the samples captured in a block are contiguous. In continuous
analysis, some samples may be missing between blocks.

To perform a one-shot analysis, click the Acquire button (or the F5 function key). To perform continuous
analysis, click the Continuous button (or the F6 function key); to stop continuous analysis, click the
Continuous button again.

If no plug-in is ready for analysis, the buttons are disabled.

The number of samples taken depends on the block size set in the test plug-in and/or the number of
points set to record in the data recorder.

The maximum block size for any test is 1,048,576 samples per channel.
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3.5.1 Data Monitor

The Data Monitor test plug-in allows for the raw data from the ADC to be displayed in the shell. The test
displays the contents of the channel that is selected from the Channel pull-down button. The channel data
are displayed with the left side of the indicator as a decimal equivalent of the code value and the right side
showing the channel data as a hexadecimal number equivalent to the code value, as shown in Figure 15.
The right hand side display of the data can be modified to display the data in decimal, hexadecimal, octal,
binary, or Sl notation format by selecting the small gray box located just to the left of the data.

File EVM Test Tools Settings Help

Ch\Program Files (x86)\ADCPro\pluginshevm®, =

i

T

L3

]

4

Figure 15. Data Monitor Test Plug-In
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3.5.2

MultiScope

The MultiScope test plug-in (shown in Figure 16) is similar to a multichannel oscilloscope. It displays the
acquired data in a time domain. From this type of plot, one can determine offset and gain errors if the
signal amplitude and offset are known, the same as with a conventional oscilloscope.

& ADCPro
File EVM Test Tools Settings Help

" | | Acquire ' | Continuous ' Data recorder

samples

*

Multichannel Scope
Channel 1
16-bit, Sine @ 1.0000kHz, 0.0 dBFS

Channel 2
16-bit, Sine @ 2.7500kHz, 0.0 dBFS

Channel 3
16-bit, Sine @ 4.3000kHz, 0.0 dBFS

1|

CICHC

Volts

\I IU[

||| ! i \ \
Sampling Frequency | 44100 5P5 |‘| ‘H 1 H \ ‘ HH w ’ ” H ||‘| ||H
Channel 3 Tl | ‘ “ H ‘H ‘
Waveform I Sine .‘ ‘ J‘ H‘ | ‘ H | H | ‘ |
I | |
Resclution Ilﬁ t | i i
Max Veolt IU Max code IBE?G? —— X Y = ._@Jﬂ
Min Volt I-lﬂ Min code |—32?68 =l Magnitude Scale Settings|
- Range | /FSR  © Auto
Display Only Block size _
Signal Frequency I 4.3kHz CH1 J|Plot All i)IT Units Codes
Channels - 9/ Volts
Amplitude (dBFS) T

[N R
-150 -125 -1000 -75 -50 -25 O

Figure 16. MultiScope Plug-In Display

Unlike an oscilloscope, however, the MultiScope plug-in can display the signal either in volts (as one
would view signals with a conventional oscilloscope) , codes, or as a custom function of the codes or
volts. This selection is made using the Units control on the right-hand side of the front panel. See
Section 3.5.2.1 for details on using the Custom units option.

The vertical scaling of the display may be set using the Range control. When set to FSR, the vertical axis
is set to the full-scale range of the converter; when set to Auto, the vertical axis is scaled to best fit the
actual signal range being measured.

The horizontal scaling of the display is determined by the Block Size—the number of samples acquired in
one block. Remember that when the Acquire button is pressed, the number of samples captured is equal
to the Block Size.

When checked, the Plot All check box causes the MultiScope plug-in to display all the channels currently
acquired. These channels are shown in the legend below the Display Only control, which is disabled
when Plot All is checked. When Plot All is not checked, only a single channel (selected with the Display
Only control) is displayed. This same option is used on several other test plug-ins.
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3.5.2.1 Custom Units on the Graphic Display

To use the custom units control, select the Custom option in the control; notice that two additional controls
appear beneath the Units control. These controls are shown in Figure 17. The Equation control displays
the current equation that calculates the displayed units. The Edit control allows the user to open the
equation editor to change the custom equation.

Figure 17. Custom Units Control

The equation editor is shown in Figure 18. Use the Conversion Factor Equation control to enter the
desired equation into the plug-in. The Custom Units control allows the user to specify the unit label that
will appear on the Y-axis of the MultiScope display. The Clear button clears the Conversion Factor
Equation field if the user wants to start over or enter a new equation. The Close button closes the
equation editor and processes the equation entered in the Conversion Factor Equation control. The
Available Variables window shows variables that are available for use in the equation that relate to the
data. These variables can be inserted into the custom equation using the drag and drop method (that is,
dropping them into the Conversion Factor Equation control).

ADC Data Values
<Voltage»

<Codes=

Figure 18. Equation Editor Screen
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When creating the custom equation, there are several rules that must be followed in order for the equation
to be recognized by the editor. These rules are displayed on the equation editor panel for reference. An
example equation is shown in Figure 19.

& Custom Units Equation Editor

Conversion Factor Equation | (<Voltages /MaxVolts)-1

Custom Units (¥ axis Label) | % Max Voltage -1]

Available Variables
Rules:

=l ADC Data Values & 1. Available operations: +, -, /,, ™ (power)
=Voltage> 2. <Voltage> or <Codes> must be in the equation
<Codes> (drag and drop from variables).

= Constants 3. Megative bers should be rep d with p hesi:
Bl Example: -1 => (-1).

= Channel Variables
MinVolts
MaxVolts

MinCode
e l‘

Figure 19. Equation Editor Screen—Example Equation

1. Available operations for the equation editor are addition (+), subtraction(-), multiplication (*), division(/),
and power(™). All operations follow the standard mathematical order of operations, and parentheses
can be used to change the processing sequence. For example, 2+3*6 = 20, while (2+3)*6 = 30.

2. Either the <Voltage> or <Codes> variable MUST be present in the final custom equation. The variable
is where the data collected will be inserted into the equation for evaluation.

3. Negative numbers must be represented using parentheses to surround the negative number. For
example, —1 should be represented as (-1).

Once the custom equation is entered, make sure the Custom Units control is filled in with the desired Y-
axis label; then select the Close button. The equation editor will disappear and the graphic display will be
updated to show the results of the custom equation (see Figure 20). The Units control holds the last
equation entered in memory, so the user can switch back to the other options without having to re-enter
the equation.

fi ADCPro
File EVM Test Tools Settings Help
a | Acquire ' | Continuous ' Data recorder samples ¢
Multichannel Scope
Channel 1 49

16-bit, Sine @ 1.0000kHz, 0.0 dBFS

Channel 2
16-bit, Sine @ 2.7500kHz, 0.0 dBFS

Channel 3
16-bit, Sine @ 4.3000kHz, 0.0 dBFS

CICIC

% Max Voltage -1

" f|(!' "‘ |" hn' w I'Mf I 'M !M i 'luyl
h | i [‘ L ( \‘ MH

’*

‘ |
Channeid < | ‘ ‘ ‘ H ‘ H H ’ H‘ H ‘
Wavefmml Sine | l| | ‘ M " ‘ |‘ ‘ | ‘| U d
|
Resolution |16 l ‘ | | I |
100 150 ZUU 150 300 350 400 450 511
Samnle
Max Volt IG Max code {32767 | Cursors: X iy — -;@Jﬂi
Min Volt |-1C| Min code | -32768 | = Magnitude Scale Settings|
Range | PSR @ Aut
Display Only Block size ) o
Signal Frequency I 4.3kHz CHL /| Plot All jlr Units Codes
: Channels ¥ Volts
Amplitude (dBFS) & Trsem

450125 100 75 S0 25 0

Equation | (<Voltage>/MaxVolts)-1

Figure 20. Multiscope Display Screen with Custom Equation
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3.5.2.2  MultiScope Graphic Display Options

Three graph tools (Cursor Movement, Zoom and Panning Tool) are located on the lower right side of the
graph display (as shown in Figure 21). The Cursor Movement Tool, a small crosshair, moves the cursor
on the display. The Zoom Tool (a magnifying glass) zooms in and out of the display. The Panning Tool
(the hand icon) picks up the plot and moves it around on the display.

e

Figure 21. Graph Controls

The Cursors control box is located on the lower left side of the graph (as shown in Figure 22). This
control allows users to add cursors to the graph, as can be done with oscilloscopes. Add a cursor to the
graph by right-clicking in the Cursor display box and selecting Create Cursor. The cursor can be one of
two types: Free and Single Plot.

Cursors: X | ¥ il
AINL | 44 -0.999237 4

Figure 22. Cursors Display Box

The Free cursor type moves the cursor freely within the plot area, regardless of plot position. The Single
Plot cursor positions the cursor only on the plot that is associated with the cursor. The cursor moves along
the associated plot. If the cursor is out of view, right-click on the Cursor display box and select Bring to
Center. The cursor is accessed by left-clicking the crosshair box located on the lower right-hand corner of
the graph (that is, Graph Tools). More control options for cursors are available by right-clicking on the
cursors box.

As with more powerful oscilloscopes, it is possible to zoom in and out of the graph display. Start by left-
clicking on the magnifying glass located on the lower right-hand side of the graph (that is, Graph Tools).
The Zoom to Rectangle option allows the user to click on a point on the display that is to be the corner of
the zoom area, and drag the tool until the rectangle covers the zoom area.

The X-zoom option allows the user to zoom in on an area of the graph along the x-axis. The Y-zoom
option allows the user to zoom in on an area of the graph along the y-axis. Zoom In about Point allows the
user to click a point to zoom in on. Press and hold the <Shift> key to switch